Lightroom Classic CC
and Lightroom CC
August 2018 update

This August Adobe have updated Lightroom Classic CC 7.5 and
Lightroom CC. The Lightroom Classic CC release includes new book
layouts and paper options you can choose from when working in

the Book module. There is also the ability to edit photo cells in Book
module and save these as new Page layouts. Plus, you can now easily
import older presets and profiles into Lightroom Classic CC.

Lightroom CC for desktop allows you to select albums to browse pho-
tos offline, for those times when you suspect the Internet connection
where you are heading to be slow or non-existent. Lightroom CC for
mobile users will benefit from new organizational and selection fea-
tures plus depth map support for more recent iPhone model cameras.



BOOK MODULE UPDATES

A number of improvements have been made to the Book module, which give you
access to the newest Blurb book styles as well as more control over your book
layout designs.

BOOK SETTINGS PANEL

The Book Settings panel (Figure 1) features new Blurb book styles that include

a Layflat paper type for Blurb Photo books plus the new Blurb Magazines, and
Blurb Trade Books styles. Photo books created using Layflat paper have seamless
spreads. This opens up the available design options for centre-spread layouts.
When using Standard Layflat, the minimum page count is 33 pages. This is due to
the binding requirements. The Magazine format can be used to create high-end
magazines with a semi-gloss cover or velvet finish paper. Trade Books meanwhile,
offer an affordable, alternative book format.

Book Settings V¥ Book Settings V¥

Book : 1 Blurb Photo Book
Blurb Magazine

Size: Blurb Trade Book Size: Small Square
PDF

Cover: JPEG Cover : Softcover

Paper Type: Paper Type: v Premium Lustre
Premium Matte

ProLine Uncoated

ProLine Pearl Photo

Estimated Price: US $41.94 Estimated Price: Standard

Logo Page: None Logo Page:

Learn More... Learn IV

Book Settings V¥ Book Settings

Book : Blurb Trade Book Book : Blurb Magazine

Size: 5x8in (13 x20cm) Size: Magazine Size
Cover: Softcover Cover: Softcover
Paper Type: Standard Color Paper Paper Type: Magazine Paper
Logo Page: None Logo Page: None

Estimated Price: US $13.71 Estimated Price: US $16.39

Learn More... Learn More...

Figure 1 The Book Settings panel new layout options.
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PAGE PANEL

You can now select where page numbers are printed on a book, including on only
left or right pages, or on all pages. To do this, go to the Page panel (Figure 2)
and check the Page Numbers box. From the Location menu you can choose where
the page numbers should appear in the page layout. Below that is the Display
menu where you can choose to have numbers displayed on both pages or left
pages or right pages only.

Page Vv Page Vv

¥ Page Numbers ¥ Page Numbers

Top Corner

Location: Location: Bottom Corner

Display: Display:
Top
Side
Bottom

Left Only
Right Only

Add Page Add Blank Add Page Add Blank

Figure 2 The new Page panel new options.

CUSTOMIZING THE PAGE CELLS

You can now refine the layout with custom-sized cells within a page layout. These
can be any size you want and not restricted by the standard padding. You can add
multiple cells to a page layout, move them to the front or back and place a cell
exactly where you want it. When you have finished editing a layout you can save
this as a custom page layout setting.

To add a new cell to a page, go to a full page view and select a page layout.
Right-click anywhere on the page and choose Add Cell = Photo or Photo
Description from the context menu. To resize a cell, click on the cell to activate

it. Then click on the square icon in the centre of the bounding box and drag to
reposition it. Or, you can hold down the key and use the keyboard arrow

keys to move a selected cell. To adjust the size of a cell, drag one of the corner
handles of the bounding box. You can arrange the placement of a cell by sending
it forward or backward on a layout. Select a cell, right-click and choose one of the
Send to Back or Bring To Front options from the context menu. Lastly, you can use
the same context menu to save the edited layout as a custom page.
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¥ Page Numbers

Bottom Corner
Left and Right

Add Cell > Photo il

Photo Description
Add Page e
Add Blank Page
Copy Layout

Remove Page
Save as Custom Page

Hide Page Number
Start Page Number
 Apply Page Number Style Globally

1. To add a new photo cell to a Book page layout, right-click and choose Add
Cell = Photo from the context menu (here | chose to add a Photo cell).

v’ Show Guides

¥ Page Bleed
v Text Safe Area
v’ Photo Cells

¥ Page Grid
¥’ Guide Lines

2. To move the added cell, click to activate the cell, click the square in the centre
and drag to reposition. It can help to have the Page Grid and Guide Lines selected
in the Guides panel as you do this.
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Bring To Front

Zoom Photo Ta Fill Cell

Remove Phata

Add Cell

Add Page
Add Blank Page

Copy Layout
Pasta Layout

Remove Selected Cell

Remove Page
Save as Custom Page

Hide Page Number
Start Page Number
v Apply Page Number Style Globally

4. To adjust the arrangement of the cell, click to select a cell. Next, right-click to
access the context menu and choose to send either backwards or forwards. You
can also use this menu to choose “Save as Custom Page” and save the new layout.

Page Numbers

Bottom Corner
Left and Right
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IMPORT PRESETS AND PROFILES

You can import a zip archive of presets and profiles, provided the zip archive
contains XMP presets, XMP profiles, DCP profiles and LCP profiles. To do this the
presets and profiles you wish to import must first be archived as a zip file.

To carry out an import you can go to the File menu and choose File = Import
Develop Profiles and Presets. This can be used to import both presets and profiles.
To import profiles only, go to the Basic panel Profile Browser (Figure 3), click the
plus (+) icon at the upper-left corner and choose Import Profiles from the menu.
To import new presets only, go to the Presets panel (Figure 4), click the plus (+)
icon at the upper-right corner and choose Import Presets from the menu. In each
case, when the import dialog that appears, select the .zip archive containing
profiles and presets you want to import. Lightroom will then automatically place
the presets and profiles in the correct locations on your system.

¥ Presets
Create Preset...
» Color

> Creative
> B&W Manage Presets...

Curve

=
=
» Sharpening
=

Vignetting

bw

Camera Calibration
Camera presets
Capture One Simulation
Default settings
HSL Black & White
HSL Hue Shifts
Process Versions
Reset folder
Special effects
Split Toning

Tone Adjustments
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[ =
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[ =
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Video effects

User Presets

Figure 4 The Presets panel Import Presets menu.

HEIC IMAGE FILES SUPPORT ON WINDOWS

Lightroom Classic CC now supports Apple’s HEIC image file format on Windows 10.

All Color B&W

Vv Favorites (6)

Figure 3  The Profile Browser Import
Profiles menu.
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LIGHTROOM CC FOR DESKTOP

OFFLINE EDITING FOR ALBUMS

The Album context menu has a “Store Album Locally” setting (see Figure 5). This
ensures original copies of the album'’s photos are stored locally on your computer.
It is most useful if you are running Lightroom CC for Desktop on a laptop com-
puter while travelling and you are unsure if the bandwidth in your hotel room will
be sufficient, or you are about to hop on a plane for a long journey.

Share Album...

Rename Album...
Add Photo ta Album “Ashridge bluebells”

Set “Ashridge bluebells” as the Target Album

" Store Album Locally.

Delete Album...

Figure 5 The Lightroom CC for Desktop Albums context menu, which includes “Store Album Locally”
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ALBUM VIEW IN THE INFO PANEL

The Info panel in Lightroom CC for Desktop now has an Albums section at the
bottom, which can be used to see which albums a particular photo belongs to
(highlighted in Figure 6). As you work in Lightroom CC you are likely to share
photos across more than one album. This new addition lets you locate other
albums more easily.

Figure 6 The Lightroom CC for Desktop Info panel Albums section.
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LIGHTROOM CC MOBILE

1OS

This release of Lightroom CC for iOS has a number of new organizational features.
First off, two new smart folders (Lr Camera Photos and Recently Added) have
been included (see Figure 7). The Shared Albums tab (Figure 8) filter displays all
the albums you currently shared on lightroom.adobe.com.

Figure 7 The new Lightroom CC for
. . iOS Camera Photos and Recently Added
Multi-selecting photos Smart Folders.

A long tap on a photo thumbnail followed by a drag, is a new gesture that can be
used when making a multi-selection of photos (see Figure 9). It's important you
lift your finger briefly after making the long tap before tapping or dragging to add
more photos to a selection.

Cancel

Figure 9 Multi-selecting photos in Lightroom CC for jOS. Figure 8 The Shared Albums tab.

HDR and long exposure photos

HDR and long exposure photos captured using the Lightroom CC Camera are now
more compact. They are typically less than half the previous files size, but without
any loss in visual quality. Consequently, they will take up less space on your device
and less time to upload.
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Filter menu updates

The Filter menu (Figure 10) has been updated. You can now filter your photos by
Media type, Camera, Location, Keywords, and whether or not the photo has been

edited yet in Lightroom CC.

Depth Map Support
The iPhone 7 Plus, iPhone 8 or iPhone X are capable of capturing HEIC files
with depth maps. If you go to the Lightroom CC for iOS settings = Technology

Previews section, you can enable the Lightroom camera (or other capture apps) to
capture photos with depth maps. A new Depth selection tool can be used to turn
a depth map into a selection that can be modified with a brush. Having done that

you can edit the selection just like a normal brush selection and modify the Edit
settings. There is now also support for the HEIC format on Android devices.

Guided tutorials

Don't forget the new Guided Tutorials that can also be accessed via the
Lightroom CC for mobile Settings = Help & Support section (see Figure 12).
Here you can find a number of tutorials that will help you learn how to work
with Lightroom CC for mobile. Included here is now a tutorial on how to apply
watermarks to photos exported from your device.

ANDROID

Android users will see that Lightroom CC for Android has an Optics editing
section with the ability to “Remove Chromatic Aberration” and “Enable lens
Corrections”. You can also pause and resume synchronization within the
Lightroom Cloud status tab (see Figure 11).

Lightroom CC

Synced and Backed Up

@ Pouse Syncing

Figure 11  Lightroom Cloud Status view on Android.

BEST PHOTOS

The Best Photos feature, which was first available on lightroom.adobe.com, is now
available as a technology preview on Android. The Best Photos feature combines
Adobe’s Al technology along with edits you have made to you photos to quickly

create a recommended selection of the best photos within a selected album.

Filter By

Figure 10 The Filter menu.

Adding a Watermark

Figure 12  Guided Tutorials on
Lightrooom CC for mobile.
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The Adobe Photoshop Lightroom Classic CC Book by Martin Evening
752 pages + Website with videos and free downloads

www.thelightroombook.com
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